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RSC - Remote Serial Communications 
 

 1 Introduction 
The Remote Serial Communications (RSC) system is a communication package 
that allows RS232 serial communications to be transported over modern 
communications networks. The system uses the power of the IP network to 
provide access to remote serial devices as well as a reliable end-to-end serial 
communication path between two serial ports. 
 
Many software applications have been written to communicate with serial devices 
that are directly connected to the computer's COM ports. These devices are 
sometimes moved to remote locations where, due to distance limitations can no 
longer be directly connected to their servers. 
 
In order to enable these applications to communicate with serial devices across 
an IP network infrastructure, a solution, which is seamless to both the application 
and device, is required. 
 
The RSC communications system uses industry standard IP protocols to address 
these requirements in two major ways. The system allows telnet access to the 
remote serial ports for remote access and monitoring. The client / server 
configuration brokers an IP communication path between two serial ports and 
provides a reliable end to end communication path between the applications 
software and the target serial device. 
 
 
 2 Example Applications 
While RSC is very flexible and not tied to any specific application or industry it 
has had extensive use in the wireless industry. Below are some examples. 
 

 2.1 TNPP over IP / Internet 
The RSC System is a great solution for network connections to remote paging 
systems. TNPP over the Internet provides a cost effective and reliable alternative 
to expensive dedicated facilities. Another unique feature is the ability to have 
multiple concurrent connections. This allows the technicians to monitor the data 
without affecting the TNPP traffic. This can be a handy tool while troubleshooting 
data communications problems. 
 

 2.2 Operator Ports 
The RSC System is a great tool for providing local and remote access to paging 
systems. The operator can use a cheap PC or an existing computer to replace 
the Glenayre's old and expensive "dumb terminal" for CN00 access. Using RSC, 
all CN00 activity can be recorded to a log file that can provide invaluable 
information during error conditions and system crashes.  
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The multiple concurrent connections capability allows multiple employees to 
participate in the system menus and connections. This creates a virtual training 
classroom from any location(s). This feature can also be extremely useful as fast 
and convenient system access is required to minimize customer outages. 
 
Gone are the days of having to fight modem errors and long distance access 
issues associated with dedicated telephone / modem lines. With RSC any 
authorized user can quickly access system with an efficient reliable connection. 
Solving customer service or system related issues are as close as a pc (telnet 
client, command prompt, many cell phone pda's etc.). 
 
Another side benefit of RSC is that the system will generally require less operator 
ports. Users find that they no longer need a dedicated dumb terminal on their 
workstation. Operators prefer accessing the Glenayre from a scalable window on 
their existing pc. With RSC, users can handle service calls from any pc in the 
world. With a common pool of access ports more operators can share a given 
group of Glenayre ports. Each RSC port is configurable with a timeout so ports 
with no activity are release back to the pool for access to a larger number of 
users. The multiple concurrent connections capability allow senior staff to train 
and monitor transactions in real time. 
 
 

 2.3 Printer Logs and Reports 
The RSC System was designed to reduce cost and increase system reliability. 
Connecting printer ports to RSC ensures that this valuable information is 
accessible. Often printers run out of paper or get locked up in error conditions. 
RSC provides an invaluable service by allowing users to monitor and log all error 
transactions. An intermittent problem can easily be pinpointed by searching 
through electronic copies of the printer log. This is a sharp contrast to digging 
through boxes of old printouts. 
 
 

 2.4 TAP over IP / Internet:  
TAP over IP and connections over the Internet are excellent alternatives to 
expensive dialup and dedicated TAP facilities. RSC connections are much more 
reliable and efficient and provide many cost saving alternatives. RSC can also be 
used with simple applications to replace a dedicated paging system at strategic 
customer sites (such as a hospital or large customer). 
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 3 RSC Server 
 
The Remote Serial Communication (RSC) Server accepts IP based 
communications sessions from a remote client and forwards communications to 
the server's local serial port.  
 
Using the RSC client, the system establishes an IP communication path between 
two serial ports and provides a reliable end-to-end communication path between 
the applications software and the target serial device. 
 
A remote user can also establish a telnet session to server and transparently 
gain access to the serial device connected to the RSC server. This allows remote 
access and monitoring capabilities to the remote device. 
 
The admin can remotely configure the RSC server's settings via a graphical user 
interface. 
 
 
 4 RSC Client 
 
The Remote Serial Communication (RSC) Client is a COM port re-director. The 
client accepts serial communication on a local serial port and forwards the data 
to the target serial device connected to the RSC Server across the IP/Ethernet 
network.  
 
All COM port data sent by the application is re-directed by RSC Client across the 
IP/Ethernet network to RSC Servers that have the target serial devices 
connected to them.  
 
Data and serial port signaling is transparently communicated between the 
application and serial device. Application software changes are not required, 
eliminating costly upgrades and modifications. 
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 5 RSC Configuration 
The program RSCServerConfig manages the user interface and system 
configuration settings. Normally this program is optioned to start when the user 
logs into windows and is minimized to the system tray. 
 
Start the program from the windows start bar or click on the blue icon  in the 
system tray to bring up the RSC Server Settings screen. 
 

 5.1 Server Settings 
The Server Settings screen is the main activity and configuration screen for the 
RSC System. The screen is divided into three major parts: 
 

 Port Settings: Defines the configuration settings for each serial port. 
 

 Port Counters: Displays activity counters for each serial port. 
 

 Connections: Displays IP connection status for each serial port. 
 

Figure 1:  Server Settings screen 
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5.1.1 Port Settings 

5.1.1.1 Port Number: COM1 – COM16 
The port number is a drop down box that selects the specific serial port number 
to display and configure. This number corresponds to the computers COM port. 
The RSC software license determines the maximum number of serial ports 
controlled by the system.  
 
Note: RSC inventories and indexes the port numbers from the first COM port 
reported by windows. This is performed at boot time and when the RSC Server is 
restarted. 
 
Please note that adding new COM ports or changing windows COM port 
configurations may change the associations with the RSC configuration. 
 
 

5.1.1.2 Port Type: Server, Client 
The Port Type parameter is used to define the Client or Server operating mode of 
the RSC serial port. As a Server, RSC functions as a receiver and listens for 
requests on an IP socket. As a Client, RSC functions as a sender and opens a 
telnet connection to the defined IP address. Once connected, RSC will 
communicate via telnet to the serial port. 
 
The Server function is used for most applications including an operator port, a 
local printer port logger and the receiving or consolidating point of a TAP or 
TNPP connection. 
 
The Client function is used to initiate IP connections to RSC from legacy serial 
devices. Examples include TNPP over the Internet, dedicated TAP over the 
Internet, remote printer connections and remote dumb terminals. 
 

5.1.1.3 Enabled: True, False 
The Enabled parameter is the On / Off switch for RSC. When set to True, RSC is 
enabled and takes control of the serial port to perform the client or server 
function.  
 
Note: When Enabled, RSC takes exclusive control of the serial port. If the COM 
has problems or is use by another windows application, the Enabled field will 
display “False” to indicate the conflict. 
 

5.1.1.4 Accept Input: True, False 
The Accept Input parameter is used in special applications. This setting inhibits a 
telnet connection from sending data to the serial port. This creates remote 
access to the serial port in a read only or listen only mode. 
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With this setting set to True, data received from the serial port is transmitted to 
the telnet device in the normal fashion. Data received from the telnet device is 
discarded. 
 

5.1.1.5 DTR Enabled: True, False 
The DTR Enabled parameter is used to control the output of the RS232 
handshake line Data Terminal Ready. When set to True the DTR signal outputs a 
steady state “True” signal. When set to False the DTR signal outputs a steady 
state “False” signal.  
 

5.1.1.6 RTS Enabled: True, False 
The RTS Enabled parameter is used to control the output of the RS232 
handshake line Request To Send. When set to True the RTS signal outputs a 
steady state “True” signal. When set to False the RTS signal outputs a steady 
state “False” signal.  
 
Note: When the “Handshaking” parameter is set to “RTS/CTS” or “Both” the RTS 
signal is maintained by RSC regardless of the RTS Enabled Settings.  
 

5.1.1.7 Input Buffer Size: 512, 1024, 2048, 4096 
The Input Buffer Size parameter is used to buffer (or store) serial data received 
from the serial port before forwarding to the associated telnet connection. 
 

5.1.1.8 Output Buffer Size: 512, 1024, 2048, 4096 
The Output Buffer Size parameter is used to buffer (or store) serial data received 
from telnet connections before forwarding to the associated serial port. 
 

5.1.1.9 Baud Rate: 300, 1200, 2400, 4800, 9600, 19200 
The Baud Rate parameter is used to define the data rate of the COM port. This 
setting must match the settings of the connected serial device. 
 

5.1.1.10 Data Setting: n,8,1   e,7,1  
The Baud Rate parameter is used to define the parity, data bits and stops bits of 
the COM port. This setting must match the settings of the connected serial 
device. 
 

5.1.1.11 Handshaking: None, Xon/Xoff, RTS/CTS, Both 
The Handshaking parameter is used to enable or disable hardware and software 
flow control on the serial port. Options include; “None” no flow control, “Xon/Xoff” 
software flow control and “RTS/ CTS” hardware flow control. When set to “Both”, 
Xon/Xoff and RTS/CTS flow control is enabled. 
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5.1.1.12 Connect Password: Secret, User_Programmable 
The Connect Password parameter allows the administrator to set a password 
that will be required to establish a connection to this serial port. The default value 
is “Secret”. Erasing the data in this parameter will allow connections without a 
password. 
 
Note: If a password is set and the wrong password is entered, the connection will 
be rejected and future connection refused depending on the parameters “Max 
Password Attempts” and “Bad Password Lockout Time”. 
 

5.1.1.13 Log File\Path Name: User_Programmable 
The Log File\Path Name parameter allows the administrator to enable serial data 
to be logged to a text file. To enable logging simply type in a fully qualified 
windows path and file name. Example: C:\logs\CN01.TXT. Erasing the data in 
this parameter disables this logging option. 
 
Note: The administrator must manually create the windows directory associated 
with the log file. RSC will automatically create and append to the specified file 
name. The administrator is responsible for maintaining log files.  RSC will 
continue to write to a file until the hard disk is filled up.  The maximum log file 
size is approximately 2 Gigabytes 
 

5.1.1.14 Port Description: User_Programmable 
The Port Description parameter is a user-defined field that is not used by the 
program. The user is encouraged to use this field to describe the connected 
device or application associated with this serial port. 
 
 

5.1.2 Server Settings 
 
The following settings are available when the “Port Type” parameter is set to the 
“Server” application.  
 

5.1.2.1 Max Connections: 0 - 10 
The Max Connections parameter sets the number of simultaneous connection 
allowed on this serial port. The default value for a server is 3, which allows up to 
three simultaneous users to connect and share this serial port. 
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5.1.2.2 Max Idle Time: 10 minutes – 32 hours, No Time Out 
The Max Idle Time parameter is used to disconnect connections that have been 
inactive for long time periods. This feature minimizes bandwidth requirements 
and frees up inactive ports. 
 

5.1.2.3 Max Password Attempts: 1 – 10, No Limit 
The Max Password Attempts parameter sets the number of bad password 
attempts allowed before the connection is disconnected. The default value is 3.  
 
When the optional “Connect Password” parameter is set this parameter is utilized 
for security purposes. After establishing a connection, the user is presented with 
the prompt “Password:”. The user is allowed up to 45 seconds to enter a valid 
password. If no password is entered the session is disconnected. 
 
If the correct password is entered, RSC displays “Connected....” and allows the 
user to access the serial port. 
 
If the wrong password is entered, RSC displays: “Invalid Password....” If more 
attempts are available, RSC displays “password:” to allow the user to try again. If 
the  
“Max Password Attempts” has been reached the session is disconnected. 
 

5.1.2.4 Bad Password Lockout Time: No Lockout, 10 – 120 minutes 
The Bad Password Lockout Time setting comes into play when a user has 
entered the wrong password beyond the “Max Password Attempts” parameter.  
 
If the Bad Password Lockout Time setting is programmed for “No Lockout” 
further connections are allowed. If the value is set to a lockout time of 10 to 120 
minutes, RSC will refuse connection attempts during the defined time period. 
 
Note: During the Bad Password Lockout Time period, all connection attempts for 
this serial port are ignored and will result in an error from the telnet client. 
Examples include: “Connect failed”, “TELNET Winsock Error – Connect failed 
Error No.(0)“, “Unable to connect to host_name  port_number”. 
 
After the Bad Password Lockout Time period has expired, RSC will resume 
normal operations and allow further connections. 
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5.1.3 Client Settings 
 
The following settings are available when the “Port Type” parameter is set to the 
“Client” application. 
 

5.1.3.1 Always Connect: True, False 
The Always Connect parameter is used in special applications where the client 
must maintain a connection to the server. Examples include a remote printer that 
would rarely send transmissions. 
 

5.1.3.2 Remote IP Address: aaa.bbb.ccc.ddd 
The Remote IP Address parameter defines the IP address or resolvable Host 
Name of the device to establish connectivity. 
 

5.1.3.3 Remote IP Port: xxxxx 
The Remote IP Port parameter defines the IP port of the device to establish 
connectivity. 
 

5.1.4 Update 
The Update button saves the programmed parameters for the specified serial 
port. When the user presses this button, settings are saved and the values are 
passed to the RSC Server for immediate execution. 
 
 

5.1.5 Port Counters 
The Port Counters are used to display activity counters for each serial port. This 
is useful for gathering statistics and troubleshooting issues on serial ports and 
telnet connections. 
 
The following provides more information on each of the associated fields: 
 

5.1.5.1 Last Cleared: 0 - 2000000000 
Displays the time and date when the Port Counters were last cleared to zero. 
 

5.1.5.2 Framing Error: 0 - 2000000000 
Displays the number of characters received from the serial port with a framing 
error. 
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5.1.5.3 Port Over Run: 0 - 2000000000 
Displays the number of characters overrun on the serial port. 
 

5.1.5.4 Rx Buffer Over Run: 0 - 2000000000 
Displays the number of characters received from the serial port that resulted in a 
buffer overrun.  
 

5.1.5.5 Tx Buffer Over Run: 0 - 2000000000 
Displays the number of characters transmitter to the serial port that resulted in a 
buffer overrun. 
 

5.1.5.6 Parity Error: 0 - 2000000000 
Displays the number of characters received from the serial port with parity errors. 
 

5.1.5.7 Rx Bytes: 0 - 2000000000 
Displays the number of characters received “from the serial port”. 
 

5.1.5.8 Tx Bytes: 0 - 2000000000 
Displays the number of characters transmitter “to the serial port”. 

 

5.1.5.9 Password Failures: 0 - 2000000000 
Displays the number of times the port denied access due to an incorrect 
password. 
 

5.1.5.10 Successful Connections: 0 - 2000000000 
Displays the number of times the port was successfully connected. 
 

5.1.5.11 Idle Connection Timeouts: 0 - 2000000000 
Displays the number of times the port was disconnected due to no activity 
transmitted to the serial port (see "Max Idle Time" parameter). 
 

5.1.5.12 Refresh 
This button "refreshes" the Port Counters to the latest values.  
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5.1.5.13 Clear 
This button "clears" the Port Counters to zero and sets the "Last Cleared" date 
field. 

 

5.1.6 Connections 
The "Connections window" displays a list of active connections to the COM port. 
There are 5 columns displayed:  

5.1.6.1 Index: 1 - 10 
Displays the index or reference number of the active connection(s). 
 

5.1.6.2 Connection Time: 1 - 10 
Displays the time and date when the connection was established. 
 

5.1.6.3 C: 1 - 10 
Displays the "Connection State" of the IP socket connection. A value 7 is the 
normal connection state. 
The complete lists of states are as follows:  

0 – Closed 
1 – Open 
2 – Listening 
3 - Connection pending 
4 - Resolving Host 
5 - Host resolved 
6 – Connecting 
7 – Connected 
8 - Peer is closing the connection 
9 - Error  

 

5.1.6.4 IP Address: aaa.bbb.ccc.ddd 
Displays the IP address of the active connection. 
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 5.2 Server Settings - Sub Menu 
 
The RSC Server Configuration program has two Sub Menus; File and Help.  
 

 File Menu: The File Menu there are five options; Trace Window, Minimize 
to Tray, Settings, License Entry and Exit.  

 
 Help Menu: The Help menu access the program Help files and 

information about the software version and licensing status. 
 
The following is an example of the pull down menu and detailed description of 
the File menu options: 

          

   

Figure 2:  File Menu selections 
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5.2.1 RSC Trace 
 

The RSC Trace Window is a system wide monitor and debug tool. This screen 
can monitor and log serial port and IP activity. Check boxes are included to 
enable monitoring of one or more serial ports. Data types to be included are 
selected by checking the Serial Events, Socket Events and Serial Data options. 
There are also options to add time stamps and log trace information to a log file.  
 
The screen is used for diagnostic purposes and can be very useful for 
troubleshooting issues on serial ports and telnet connections. 
 
The following is an example of RSC Trace screen: 
 

 
Figure 3:  RSC Trace screen 

 
Note: The Trace ports settings are not saved and thus disabled when RSC 
Server starts. 
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5.2.2 Minimize To Tray 
 
The Minimize to Tray option simply drops the RSC Server Configuration Screen 
to the Windows System Tray. While in the system tray, the program can be 
“opened” to full screen access by double clicking on the RSC icon. If the user 
right clicks on the RSC icon, the options include; Open (open to full screen 
access), About (show RSC Version and License information) and Exit (terminate 
the RSC Setup program). 
 
Below is an example of the RSC icon in the windows system tray. In this example 
RSC has 2 active IP connections: 
 

 

Figure 4:  RSC Icon in system tray 
 

Note: Pressing the “X” at the top right corner of the System Configuration Screen 
will also minimize the configuration screen to the tray. This allows the tray icon to 
act as a system status monitor. To exit the program, select File then click Exit or 
right click on the tray icon and select Exit. 
 

 
Figure 5:  Server Settings screen 

5.2.3 Settings - System Config 
 
The System Config Settings window is accessed from the File menu in the RSC 
Server Configuration program. The window is divided into three major parts:  
 

5.2.3.1 RSC Server Configuration Settings 
Defines startup options for the RSC Server Configuration (RSCSeverConfig) 
program. The “Load At Login” option is included to automatically load the 
configuration program when the user signs into windows. 
 
The second option specifies the Startup Style; Normal Window (full screen 
window), Minimized Window or Minimize to System Tray. 
 
Note: No changes occur until the Update button is activated. 

 

5.2.3.2 RSC Server Settings – Base TCP Port 
Sets the IP port offset for all telnet connections. Example: A setting of 5000 will 
define the 1st COM port to be accessed from Telnet port 5001. 



  

 

 
RSC Remote Serial Communication System Manual          Rev 1.4             Page: 17 of 34 

5.2.3.3 RSC Server Settings – Service Control 
The RSC Server Program automatically starts and runs as a windows service. 
Select Start, Stop or Restart to start or stop the RSC Server program. 
 
Note: Some RSC Server settings require the RSC service to stop and restart. 
Use the Restart option to perform this function. 
 
 
The following is an example System Config screen: 
 

 

Figure 6:  System Configuration screen 
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5.2.4 License Entry 
 
The License Entry Window is used to enter the software license information into 
the program during software installation or upgrade time. The Licensee 
information contains the user’s name or company information. The License Key 
is used to validate the software license. The Signature key contains the serial 
number of the RSC software. 
 
The following is an example License Entry screen: 

 

 

Figure 7:  License Entry screen 

 

Warning: Entering invalid Licensee or License Key data on an operational 
system will cause the system to stop operating. 
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 5.3 Help / About 
The Help menu access the program Help files and information about the software 
version and licensing status. 

 

 

 

Figure 8:  Help / About screen 
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Appendix A:  RSC Installation Example 
 
 

A.1 Start Installation Program 
Start the RSC Server installation by clicking on the RSC installation program 
RSC.EXE. Follow the install wizard prompts to complete the installation of the 
program. Below is an example RSC Server Setup screen. 
 
 

 

Figure A.1:  RSC Server Setup Wizard screen 
 
 

After the RSC installation is complete, the RSC Configuration screen is “grayed 
out” until the software license information is added to the program: 

 

Figure A.2: Initial RSC Server Settings Screen (No license entered) 
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A.2 License Entry  
  

The License Entry window is used to enter the software license information into 
the program during software installation or upgrade time. 

 

Access the license screen by clicking "File" then "License Entry". 
 

 
 

Figure A.3: RSC Server Configuration program, File Menu 

 
 
 

 
 

Figure A.4: RSC Server Configuration, License Entry window 
 

 The "Licensee" field contains the user’s name or company information.  

 The "License Key" field is the user specific key which validates the 
software license. 

 The "Signature Key" field is populated by the program and contains the 
unique serial number of the RSC software.  
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Copy the Signature Key information from the License Entry window and Email 
the Signature Key information to support@EasySolutions4You.com.  

Hint: Use the mouse to highlight the "Signature Key" information, then use 
Copy (Control C) and Paste (Control P) to transfer the Signature Key 
information to your email program. 

 
Easy Solutions will generate the corresponding Licensee and License Key to 
activate the program. After receiving the license information, please cut and 
paste the information into the appropriate fields exactly (being careful not to add 
extra spaces or carriage returns). Then press Update. 

After successfully entering the license information the program will display the 
server setting menu (see RSC Manual, Server Setting for specific setup 
information). 

 

Example License Entry: 

 

Licensee:  
ABC Wireless Company - Plano, Texas 

License Key:  
CAE7830DE0BE30D8E3433BC79939D5653302E2D3XXXXXXXXXXXXXXXX 
 
 
 

 
 

Figure A.5: RSC Server Configuration, License Entry window with example data 
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A.3 Enable COM Ports 

Once a valid RSC Server license has been entered, the Server Settings screen 
will display setup information for the first COM Port as shown below: 
 

 
 

Figure A.6: RSC Server Settings, COM1 Configuration 
 
 

The next step is to enable the COM port. Use the mouse to select the port setting 
value "Enabled True", then click "Update" to save the setting. 

Note: If any application is using the COM port, RSC will not be able to open and 
gain control of the serial port.  

The Port Setting "Enabled" status will remain at status "False" if RSC cannot 
access the COM port. 

Please remember to close any application that may be holding the serial port 
before changing configurations and pressing the Update button on the Port 
Settings. 
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A.4 Complete Configuration Requirements 
Once the COM port has gained a status of "Enabled True" the program is fully 
operational will allow TCP access to the serial port.  

The next step is to adjust any serial settings and enable all required COM ports. 
Please see the Server Settings section of the RSC Server Manual for additional 
details. 

See Appendix B for an example telnet connection. 

 



  

 

 
RSC Remote Serial Communication System Manual          Rev 1.4             Page: 25 of 34 

Appendix B:  Example Telnet Connections 
 
 
B.1 Example RSC Computer Setup Information 
 
Below is an example configuration for a RSC Computer: 
 
 
 

 
Figure B.1:  Windows System properties for RSC Computer 

 
 

Ethernet Information: 
Local LAN IP Address:  192.168.1.22 
Local LAN IP Name: PC-GL3000 
 
Internet IP Address:  Dynamic Public IP Address 
Internet IP Name:  account_name.gotdns.com 
 
 
Serial Port Information: 
Port Settings:   COM 1, 9600 8 N 1 
Description:    GL3000-ES, CN00 
RSC Access Port:   5001 
Password   xxxxxxxx 
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B.2 Telnet Syntax 
The syntax for connecting to COM1 on the RSC server is: 
    telnet <hostname> < port number> 
 
Note: Most telnet clients use a “space” between the hostname and port number 
but some use a “colon” (example: Telnet <hostname>:<port_number>). 
 
 
B.3 DOS Telnet Connection Example 
 
Most windows installations include a DOS telnet client. To access this 
functionality, simple open a DOS windows and type the following commands: 
 
Access from Local LAN Connections: 
Telnet  192.168.1.22 5001     or      telnet  PC-GL3000 5001 
 
 
Access from Internet Connections: 
Telnet  account_name.gotdns.com  5001    (Public Computer Name) 
Telnet aaa.bbb.ccc.ddd  5001                      (Public IP Address) 
 
 

 
 

 
 

 
Figure B.2:  Example DOS Telnet screens 
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B.4 HyperTerminal Setup 
 
Most windows installations include a HyperTerminal telnet client. To access this 
functionality, simply start the HyperTerminal application and set the following 
configuration options. 
 

 Change the “Connect using” connection type to TCP/IP (Winsock). 
 

 Change the host address to the RSC computer IP address. 
Enter the local LAN address (192.168.1.22) for local connections or the public 
IP Name  (account_name.gotdns.com) or public IP address for remote 
connections. 
 
 Change the port number to match the destination device. 
Example: Port 5001 for connecting to COM1. 
 
 Change the terminal emulation as required. 
Example: VT100 for GL3000. 
 

   

 

Figure B.3:  Configuration screens for telnet session on the local LAN 
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Figure B.4:  Configuration screen for telnet session through the Internet 
 
 
 
 
 
 

  

Figure B.5:  HyperTerm Desktop Icon 
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Appendix C:  Example Windows XP Firewall 
Configuration 

 
Firewalls can prevent users from accessing IP sockets on an RSC computer. The 
following information shows how to access the programming screens for the 
Windows XP firewall: 
 

 
 

Figure C.1:  HyperTerm Desktop Icon 
 
Open the Network Connections screen by right clicking on My Network Places 
icon on the desktop and select properties.  
 

 
 

One can also access the Network Connections screen from the Start Menu; 
Select Settings, then Network Connections. 
 

 
Figure C.2:  Network Connections Screens 
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On the left side under Network Tasks, click on Change Windows Firewall 
settings to bring up the Windows Firewall window.  

 

 

Figure C.3:  Network Connections screen 
 
Click on the Exceptions tab, and then click on Add program.  

 

 
Figure C.4:  Windows Firewall, Exceptions screen 
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Figure C.5:  Adding RSC Server to the Exceptions screen 
 
Click on “Browse” navigate to the RSC Server install directory and select 
RSCServer.exe (C:\Program Files\RSC Server\RSCServer.exe). 
 
Hint: Make sure to select RSCServer.exe (not RSC ServerConfig.exe). 

 
Click Open, then OK and OK to save the setting.   

 
Windows will now automatically allow RSC Server to open all associated ports 
(5001, 5002, etc). 
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Appendix D:  DB-25 and DB-9 Cables Connections 
 

The following tables show typical cable pin outs for RS232 serial ports. 
 

DB-9 to DB-25 
PC to GL3000 Cable 

 
PC (DTE)   GL3000 (DCE) 

PC RS232  GL RS232 
DB-9 Signal  DB-25 Signal 

7 RTS (Out)  4 RTS 
4 DTR (Out)  20 DTR 
5 GND * 7 GND 
3 TX    (Out) * 2 TX  
2 RX * 3 RX    (Out) 
1 CD  8 CD    (Out) 
6 DSR  6 DSR  (Out) 
8 CTS  5 CTS  (Out) 

 
Note: * DB-25 pins 2, 3 and 7 are the only required connections. 

Figure D.1:  DB-9 to DB-25, PC to GL3000 Cable 
 

 
DB-9 to DB-25 

PC to GL3000 Printer Logger Cable 
 

Add these 5 connections to the existing pins 
on the DB-25 connector attached to CN01 

 
PC (DTE)  GL3000 (DCE) 

PC RS232  GL RS232 
DB-9 Signal  DB-25 Signal 

   4 RTS 
   20 DTR 

5 GND * 7 GND 
   2 TX 

2 RX * 3 RX    (Out) 
1 CD  8 CD    (Out) 
6 DSR  6 DSR  (Out) 
8 CTS  5 CTS  (Out) 

 
Note: * DB-25 pins 3 and 7 are the only required connections. 

 
Figure D.2:  DB-9 to DB-25, PC to GL3000 Printer Logger Cable 
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Appendix E:  FAQ Frequently Asked Questions 
 
 
How can I disable RSC and use another application to communicate 
directly with the serial port. 
 
Select the associated COM port in the RSC Configuration program. Change the 
parameter “Enabled” to False. Press the “Update” button. 
 
 
RSC cannot communicate with the COM Port 
Similar issues: Serial port will not open 
 
RSC must have exclusive control over the serial port to function properly. When 
the RSC Server program starts it attempts to open all “Enabled” COM ports. Any 
port that cannot open properly is reported to the event log and displayed with the 
status Enabled: False. 
 
Various issues can cause this problem. Some examples include: 

 Another application may be using the associated COM port. 
 The COM port may have a hardware problem. 
 The COM port may be disabled in the windows control panel. 

 
To trouble shoot this problem, disable RSC form this COM port and use 
windows’ HyperTerminal to further investigate the details. 
 
See FAQ: How can I disable RSC and use another application to communicate 
directly with the serial port. 
 
 
RSC Server Configuration screen disappears to the system tray when 
starting windows. 
Similar issues: RSC Server Configuration screen is minimized to the task bar 
when starting windows. 
 
This is an optional setting that is defined in the System Config screen. To view or 
change this option; access the RSC Server Config screen, clock on File, then 
click on Settings. See Startup Style settings. 
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RSC port configurations change when adding new COM ports: 
 
RSC inventories and indexes the port numbers from the first COM port reported 
by windows. This is performed at boot time and when the RSC Server is 
restarted. 
 
RSC will control the first x amount of serial ports reported by windows (where x is 
the number of ports licensed by the RSC software). For simplicity it is 
recommended that the administrator configure the ports to be used by RSC to 
start at COM1.  
 
Example 1: Windows reports COM ports 1, 2, 3 and 4. A four port RSC license 
will default to a telnet configuration of port 5001 for COM1 (COM2 = 5002, COM3 
= 5003 and COM4 = 5004). 
 
Example 2: Windows reports COM ports 1, 4, 5, 6 and 7. A four port RSC license 
will default to a telnet configuration of port 5001 for COM1 (COM4 = 5004, COM5 
= 5005 and COM6 = 5006)  
 
Note: COM7 is not available to RSC in this example as the software is configured 
for a 4 port license. 
 


